Epson SureColor T-Series User’s Guide

Basic Operations

Basic Printing Methods
(Windows)

Printing is performed from the application used to
create the document you wish to print. The basic
procedure is described below.
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Turn on the printer, and load the paper.

5 “Attaching the Roll Paper Adapter” on page
29

5 “Loading Cut Sheets” on page 39
5 “Loading Poster Board” on page 41

When you have created the data, click Print in
the File menu.
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After confirming that the printer is selected,
click Printer properties or Properties to
display the Printer Settings tab.
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Check the options selected for Media Settings.

When using T7270/T5270/T3270

On startup, the printer driver automatically
downloads information on the media in the
printer and displays it in the Media Settings
area.

To print at current settings, proceed to the next
step.

When using T7270D/T5270D

If Roll Auto - **mm has been selected when the
printer driver starts, the printer applies the
media type and width of the roll paper currently
in use on the printer. When the printer starts
printing, it switches to the roll paper to be
printed in accordance with the Roll Switch
Condition setting in the Setup menu of the
printer.
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£ “Switching Roll Paper Automatically before
Printing (T7270D/T5270D Only)” on page 93
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If the desired settings are not displayed, replace
the media in the printer with the desired paper
type and click the Acquire Info button. The
driver will reacquire data from the printer and
update the information displayed in the Media
Settings area.

If the desired size is not available in the menu,
click Custom Paper Size to add a custom paper
size. £ “Printing at Non-Standard Sizes” on
page 90

Select "fit to" and borderless printing options.

To resize the document to fit it to the width of
the roll when using roll paper, simply select Fit
to Roll Paper Width.

To print without borders (margins), select
Borderless.

For borderless printing on paper larger than the
original document size, select both the "fit to"
and borderless options.
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Note:
If the Acquire Info button is clicked, information
about the paper loaded on the printer is displayed.

In the Size Settings area, choose the desired
Paper Size.

Choose the Paper Size selected when the
document was created in the application.
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Advanced fit and borderless settings are
available in the Layout tab.

5 “Enlargements and Horizontal and Vertical
Banners” on page 86

5 “Borderless Printing” on page 98

In the Print Quality area, choose an option for
Select Target.
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Choose an option according to the type of
document and how it will be used.
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To choose a color correction method or adjust
colors, select Advanced Settings.

25 “Correct color and print” on page 103
Check settings.

The selected settings are reflected in the area on
the right; check that settings are correct.
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Click the OK button.
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1 O When settings are complete, click Print.

The progress bar is displayed, and printing
starts.

Screen while printing

The following screen is displayed when you start
printing, and the progress bar (the computer's
processing status) is displayed. On this screen you can
check the remaining ink level, product numbers for the
ink cartridges, and so on.
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An error message is displayed if an error occurs or an H H H
ink cartridge needs replacing while printing. B asic P rin tl n g M et h o d S
(OS X)

LT EPSON Status Monitor 3 : EPSON SC-TXXXX Series ==

EPSON Error

1. Turn off the printer, disconnect power cable from electrical outlet, and ~ »
reconnect the cable.

2. Turn on the printer again. If the same error occurs, contact your dealer

or Epson Suppart for assistance. Tell them the error code displayed on
printer's screen.

l Turn on the printer, and load the paper.

£ “Attaching the Roll Paper Adapter” on page
29

Ink Levels

J J l I I £ “Loading Cut Sheets” on page 39

5 “Loading Poster Board” on page 41

2 When you have created the data, from the File
menu of the application, click Print and so on.
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3 The print screen is displayed.
OS X Lion or later

Click Show Details at the bottom of the dialog
box.

Printer: | EPSON SC-TXXXX

Copies: |1 )

Pages: [All %]

(e« 10f1 (> [#¥)

(2) [PDF wI | Show Details | I [ Cancel | [Print)
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For OS X 10.6 and 10.5, click the arrow (¥} ) to
make settings on the Page Setup screen.

Printer: | EPSON SC-TXXXX " E]
Presets: | Standard
(@) (POFv ) ((Preview ( Cancel )
Printer: | EPSON SC-TX00 : E]
Presets: | Standard B
Copies: 1 ™ Collated
Pages: @ All
OFrom: |1 o 1
Paper Size: | A4 (Sheet) + 8.26 by 11.69 inches
—

(] Print header and footer

(Cancel )

Note:

If page settings are not displayed in the print
dialog, click the "page settings" option (e.g., Page
Setup) in the File menu.

Settings: | Page Attributes +]

Format For: | Any Printer &l

Paper Size: | A4
210 by 297 mm

Orientation: ‘ LI

Scale: | 100 %

@ [ Cancel | [ 0K

4 Check that this printer is selected, and then set
the paper size.

Select one of the following options for Paper
Size. XXXX is the actual paper size, such as A4.

XXXX: Print with margins on roll paper. Print
using the Roll Paper Margin> selected on the

printer.

5 “Print Queues menu” on page 140
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XXXX (cut sheet): Print with margins on cut
sheets. Print with top, right, and left margins of
3 mm and a bottom margin of 14 mm.

Printer: | EPSON SC-TXXXX &l
Tresets: | Detaurt setngs =]
Copies: |1

Pages: (®) All

I Paper Size: | A4 + ‘Ia by 297 mm

Orientation: [J|#]] |1/3

| TextEdit

[ Print header and footer

|| Rewrap contents to fit page

| Cancel | [ Print

When performing borderless or banner
printing; see £2°“Borderless Printing” on page
98, £ “Enlargements and Horizontal and
Vertical Banners” on page 86

To view basic print settings, select Printer
Settings from the list.

OS X 10.6 or later (when using
T7270/T5270/T3270)

On startup, the printer driver automatically
downloads information on the media in the
printer and displays it in the Page Setup and
Media Type areas. To print at current settings,
proceed to the next step.

OS$ X 10.6 or later (when using
T7270D/T5270D)

If Auto has been selected for Roll Switch when
the printer driver starts, the printer applies the
media type and width of the roll paper currently
in use on the printer. When the printer starts
printing, it switches to the roll paper to be
printed in accordance with the Roll Switch
Condition setting in the Setup menu of the
printer.

5 “Switching Roll Paper Automatically before
Printing (T7270D/T5270D Only)” on page 93
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08X 10.5
Choose Page Setup and Media Type according
to the type of paper loaded in the printer.

Printer: | EPSON SC-TXXXX =)
Presets: | Default Settings B
Copies: |1
Pages: (3) All

(From: |1 tor |1

Paper Size: | A4 + | 210 by 297 mm

Orientation: W
D ——

——|_Printer Settings
Roll Paper Width: | 44 inch (1118 mm) )

Page Setup: Roll Paper

Media Type:| Premium Luster Photo Paper (260) i)

Printer information has been acquired. | Acquire Info |

MoaE, T SeIeCt Targer
() Advanced Settings

Poster(lllustration & Text)
Poster(Photo)

Office Document{Color)
Perspective/GIS

Print posters with illustrations and texts vividly.

| Max Quality - 720x1440 dpi_ * |

| Check Settings...

| Cancel | [ Print |

If the desired settings are not displayed, replace
the media in the printer with the desired paper
type and click the Acquire Info button. The
driver will reacquire data from the printer and
update the information displayed.

Choose how the printed document will be used.

Choose an option according to the type of
document and how it will be used.

Printer: | EPSON SC-TXXXX B ‘
Presets: | Default Settings B
Copies: 1
Pages: (=) All
(_JFrom: 1 to: |1

Paper Size: | A4

+| 210 by 297 mm

~——— Printer Settings
Page Setup: Roll Paper

Roll Paper Width: | 44 inch (1118 mm) ™

Media Type:| Premium Luster Photo Paper (260) i)

Printer information has been acauired. | Acquire Info |

Mode: () Select Target
(") Advanced Settings

Poster(lllustration & Text)
Poster(Photo)

Office Document(Color)
Perspective/GIS

e

| Check Settings...

| Cancel | [ Print |

To choose a color correction method or adjust
colors, select Advanced Settings for Mode.

25 “Correct color and print” on page 103
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7 Check settings.
The selected settings are reflected in the area on
the right; check that settings are correct.

When settings are complete, click Print.

8

The printer icon is displayed in the Dock while
printing. Click the printer icon to display the status.
You can check the progress of the current print job and
the printer status information. You can also cancel a
print job.

Also, if an error occurs while printing, a notification
message is displayed.

en0e =/ EPSON SC-TXXXX (1 Job)

@ m =

Delete Hold JobInfo Pause Printer Supply Levels Printer Setup

= Printing “XXXOXX"
\‘ Sending data to printer.
sy
Status Name Sent Completed
Printing Today, 19:25
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Printable area

This section describes the printable areas for the
printer.

If the margin set in an application is larger than the
following setting values, sections beyond the specified
margins are not printed. For example, if 15 mm is
selected for the left and right margins in the printer
menus and the document fills the page, the 15 mm at
the left and right sides of the page will not be printed.

Roll Paper Printable Area

The gray area in the illustration below shows the
printable area.

When printing borderless on the left and right, the left
and right margins are 0 mm. When printing borderless

on all edges, all margins are 0 mm.

The arrow in the illustration indicates the direction of
the ejected paper.

254mm~1118mm=+1

It 254mm~914mm*2 ————
ir.lnm/15mm 554mm~620mm +3 3Mm/15mm
: 1©+ 1 _[13mm/15mm
127mm
I —
15m |@ (4]
|0 3~45mm

*1T7270/T7270D

*2 T5270/T5270D

*3 T3270

*4 1f Banner is selected for Roll Paper Option in the

printer driver Advanced tab, the top and bottom
margins are 0 mm.

Margins for roll paper depend on the option selected
for Roll Paper Margin in the menus, as shown in the
table below.
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Roll Paper Margin Settings 2% “Setup menu” on page

147

indicates factory default settings.

Roll Paper Margin

Margin Values

Parameter
Normal A,C=15 mm’
B,D=3 mm
Top15mm/Bottom15mm A,C=15mm
B,D=3 mm
Top35mm/Bottom15mm A=35mm
C=15mm
B,D=3 mm
Top45mm/Bottom15mm A=45mm
C=15mm
B,D=3 mm
3mm A,B,C, D=3 mm
15 mm A,B,C,D=15mm

* When Normal is selected, the value for A is 20 mm for

the following paper.

Premium Photo Paper Glossy (250)/Premium Photo
Paper Semigloss (250)/Ultra Premium Photo Paper
Luster (260)/Premium Semimatte Photo Paper (260)

When the following media are used in CAD / Line
Drawing mode, the value for AC is 3 mm.

Singleweight Matte Paper

Important:

Q  Printing is distorted when the trailing edge of

the roll paper comes off the core. Make sure
the trailing edge does not come inside the

printing area.

O The print size does not change even when the
margins are changed.

Cut Sheets Printable Area

When printing borderless on the left and right, the left
and right margins are 0 mm. (Borderless printing is not

available with poster board.)
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The arrow in the illustration indicates the direction of
the ejected paper.

E 210mm~1118mm=+! E
ea 210mm~914mm *2 G
210mm~620mm =3
: b | f14mm
279
l
1580mm
L
3mm

*1T7270/T7270D

*2 T5270/T5270D

*3T3270
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Using the Power Off
Timer

The printer offers the following two power
management options.

O Sleep mode

The printer enters sleep mode when there are no
errors, no print jobs being received, and no control
panel or other operations performed. When the
printer enters sleep mode, the control panel's
screen turns off and the internal motors and other
parts switch off to consume less power.

Sleep mode is cleared if a print job is received or a
button on the control panel is pressed.

The delay before the printer enters sleep mode can
be selected from values between 5 and 210
minutes. At default settings, the printer enters
sleep mode if no operations are performed for 15
minutes. The delay can be changed from the Setup
menu. £ “Setup menu” on page 147

Note:

When the printer enters sleep mode, the control
panel’s screen goes blank as if the power has been
turned off, but the O light remains lit.

Power Off Timer

The printer is equipped with a Power Off Timer
option that automatically turns the printer off if no
errors occur, no print jobs are received, and no
control panel or other operations are performed
for a set period of time. The delay before the
printer turns off automatically can be selected
from values between 1 and 24 hours in increments
of 1 hour.

This section shows the default settings.
O T7270/T5270/T3270

The printer turns off automatically if no
errors occur, no print jobs are received, and
no operations on the panel or other
operations are performed for eight hours or
longer.

O T7270D/T5270D



